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BAB II 

TINJAUAN PUSTAKA 

 

2.1.  Uraian Umum 

   Pada perencanaan suatu konstruksi bangunan gedung diperlukan 

beberapa landasan teori berupa analisa struktur, ilmu tentang kekuatan 

bahan serta hal lain yang berpedoman pada peraturan-peraturan yang 

berlaku di Indonesia. Ilmu teoritis diatas tidaklah cukup karena analisa 

secara teoritis tersebut hanya berlaku pada kondisi struktur yang ideal 

sedangkan gaya-gaya yang dihitung hanya merupakan pendekatan dari 

keadaan yang sebenarnya atau yang diharapkan terjadi. 

Perencanaan bangunan merupakan suatu usaha untuk menyusun 

dan mengorganisasikan suatu proyek konstruksi baik berupa 

perhitungan-perhitungan maupun tulisan- tulisan sehingga bangunan 

yang dihasilkan sesuai dengan yang diinginkan  dan tetap memperhatikan 

standar ekonomis, aman, kuat, dan nyaman.  

 

2.2.  Ruang Lingkup Perencanaan  

Ruang lingkup dari perencanaan bangunan gedung Terpadu PMI Kota 

Palembang ini meliputi beberapa tahapan yaitu persiapan, studi kelayakan, 

mendesain bangunan (perencanaan), dilanjutkan dengan perhitungan 

struktur, lalu perhitungan biaya, dan progress kerja yang diwujudkan 

melalui NWP dan kurva S. 

 

 2.2.1. Perencanaan Konstruksi 

Struktur adalah suatu kesatuan dan rangkaian dari beberapa elemen 

yang  direncanakan  agar  mampu  menerima  beban  luar  maupun  berat 

sendiri  tanpa  mengalami  perubahan  bentuk  yang  melampaui  batas 

persyaratan. 
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Ada dua struktur pendukung bangunan yaitu :  

1. Struktur bangunan atas  

       Struktur bangunan atas harus sanggup mewujudkan perencanaan 

dari segi  arsitektur  dan  harus  mampu  menjamin  mutu  baik  dari  

segi keamanan maupun kenyamanan bagi penggunanya. Untuk itu, 

bahan bangunan yang nantinya akan digunakan sebagai bahan dasar 

dari konstruksi hendaknya memenuhi kriteria sebagai berikut :  

a. Tahan Api.  

b. Kuat dan kokoh.  

c. Mudah diperoleh, dalam arti tidak memerlukan biaya mobilisasi  

      bahan yang demikian tinggi.  

d. Awet untuk jangka waktu pemakaian yang lama.  

e. Ekonomis, dengan perawatan yang relatif mudah.  

   Dari kriteria-kriteria yang tersebut diatas, maka sebagai 

komposisi struktur utama  dari   bangunan   ini   menggunakan   

struktur   beton bertulang. Perhitungan perencanaan untuk bangunan 

struktur atas ini meliputi :  

a. Perhitungan Pelat Lantai.  

b. Perhitungan Tangga.  

c. Perbebanan Portal.  

d. Perhitungan Balok.  

e. Perhitungan Kolom.  

2. Struktur bangunan bawah  

        Struktur bangunan bawah merupakan sistem pendukung bangunan 

yang menerima beban struktur atas, untuk diteruskan ke tanah 

dibawahnya. Perhitungan perencanaan struktur bagian bawah (Sub 

Structure) ini eliputi:  

a. Perhitungan Sloof.  

b. Perhitungan pondasi.  
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2.2.2   Dasar-dasar Perencanaan  

Dalam merencanakan suatau bangunan gedung, harus berpedoman 

dengan peraturan-peraturan yang telah ditetapkan dan berlaku di Indonesia. 

Peraturan tersebut yang dapat digunakan antara lain :  

1. Peraturan Pembebanan Indonesia Untuk Gedung tahun 1987.  

2. Persyaratan Beton Struktural Beton Untuk Bangunan Gedung (SNI 

2847-2013) 

3. Beban Minimum Untuk Perancangan Bangunan Gedung dan Struktur 

Lain (SNI 1727-2013). 

4. Struktur Beton Bertulang, oleh Istimawan Dipohusodo (SK SNI T-15-

1991-03).  

5. Dasar-dasar Perencanaan Beton Bertulang seri I, oleh W.C. Vis dan 

Gideon Kusuma.  

6. Grafik dan Tabel Perhitungan Beton Bertulang, oleh W.C. Vis dan 

Gideon Kusuma.  

Suatu konstruksi bangunan gedung juga harus direncanakan  

kekuatannya terhadap suatu pembebanan. Adapun jenis pembebanannya  

antara lain :  

1.  Beban Mati  

Beban mati ialah berat dari semua bagian dari suatu gedung yang 

bersifat tetap, termasuk segala unsur tambahan, penyelesaian-

penyelesaian, mesin-mesin serta peralatan tetap yang merupakan bagian 

yang tak terpisahkan dari gedung itu.  

2.  Beban Hidup  

Beban hidup ialah semua beban yang terjadi akibat penghunian 

atau penggunaan suatu gedung, dan kedalamnya termasuk beban-

beban pada lantai yang berasal dari barang-barang yang dapat 

berpindah, mesin-mesin serta peralatan yang tidak merupakan bagian 

yang tak terpisahkan dari gedung dan dapat diganti selama masa hidup 

dari gedung itu, sehingga mengakibatkan perubahan dalam 
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pembebanan lantai dan atap tersebut. Khusus pada atap ke dalam 

beban hidup dapat termasuk beban yang berasal dari air hujan, baik 

akibat genangan maupun akibat tekanan jatuh (energy kinetic) butiran 

air. Ke dalam beban hidup tidak termasuk beban angin, beban gempa 

dan beban khusus yang disebut dalam ayat (3), (4) dan (5). 

3.  Beban Angin 

Beban angin ialah semua beban yang bekerja pada gedung 

atau bagian gedung yang disebabkan oleh selisih dalam tekanan 

udara. 

 

2.3.  Perhitungan Struktur  

Berikut adalah metode perhitungan yang akan digunakan dalam 

perhitungan konstruksi. Metode-metode tersebut diambil berdasarkan acuan 

yang digunakan. 

2.3.1  Perencanaan Pelat Atap dan Pelat Lantai 

Struktur pelat pada gedung  Terpadu PMI Kota Palembang ini terdapat 

dua jenis yaitu pelat atap daag dan pelat lantai. Berikut adalah pembahasan 

mengenai pelat: 

  Struktur pelat atap daag sama dengan struktur pelat lantai, hanya saja 

berbeda dalam  hal pembebanannya. Tentunya beban yang bekerja pada 

pelat atap lebih kecil bila dibanding dengan pelat lantai. Strukturnya adalah 

struktur pelat dua arah, sama dengan pelat lantai. Sedangkan Pelat beton 

bertulang dalam suatu struktur dipakai pada lantai, pada pelat ruang ditumpu 

balok pada keempat sisinya terbagi dua berdasarkan geometrinya, yaitu: 
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Beban-beban yang bekerja pada pelat atap dan lantai , yaitu: 

a) Beban Mati (WD) 

- Bebat sendiri pelat atap 

- Berat mortar 

b) Beban Hidup (WL) 

- Beban hidup untuk pelat atap diambil 100 kg/m
2
 dan untuk pelat lantai 

diambil 250 kg/m
2
 

(PPPRG 1987 hal.7 Pasal 2.1.2.2 ayat (1)) 

  

- Macam-macam sistem pelat : 

- Pelat Satu Arah (One Way Slab) 

Pelat satu arah yaitu suatu pelat yang memiliki panjang lebih besar 

atau lebih lebar yang bertumpu menerus melalui balok – balok. Maka 

hampir semua beban lantai dipikul oleh balok – balok yang sejajar. Suatu 

pelat dikatakan pelat satu arah apabila  Ly/Lx ≥ 2, dimana Ly dan Lx 

adalah panjang dari sisi-sisinya. 

 

 

 

 

 

 

 

 

Gambar 2.1 Pelat Satu Arah, 
Lx

Ly
 ≥ 2 

Keterangan: 

Ly , Lx = panjang pelat 
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Dalam perencanaan struktur pelat satu arah, langkah-langkahnya 

adalah sebagai berikut : 

a. Penentuan Tebal Pelat 

  Penentuan tebal pelat terlentur satu arah tergantung beban atau 

momen lentur yang bekerja, defleksi yang terjadi dan kebutuhan kuat 

geser yang dituntut. (Dipohusodo, 1999:56) 

Menurut SNI 2847-2013 pasal 9.5.2.2 dengan anggapan 

balok/pelat merupakan konstruksi satu arah, tebal minimumnya dapat 

ditetapkan berdasarkan tabel 2.1 dan untuk selimut beton pada tabel 2.2 

berikut. 

Tabel 2.1 

Tabel minimum balok non-prategang atau pelat satu arah 

bila lendutan tidak dihitung 

 

 
Tebal Minimum, h 

Komponen 

struktur 

Dua tumpuan 

sederhana 

Satu ujung 

menerus 

Kedua ujung 

menerus 
Kantilever 

Komponen yang tidak menahan atau tidak disatukan dengan 

partisi atau konstruksi lain yang mungkin akan rusak oleh 

lendutan yang besar 

Pelat masif satu 

arah 
ℓ /20 ℓ /24 ℓ /28 ℓ /10 

Balok atau pelat 

rusuk satu arah 
ℓ /16 ℓ /18,5 ℓ /21 ℓ /8 

CATATAN: 
Panjang bentang dalam mm. 
Nilai yang diberikan harus digunakan langsung untuk komponen struktur dengan beton normal dan 

tulangan tulangan Mutu 420 MPa. Untuk kondisi lain, nilai di atas harus dimodifikasikan sebagai 
berikut: 

(a) Untuk struktur beton ringan dengan berat jenis (equilibrium density), wc, di antara 1440 sampai 
1840 kg/m3, nilai tadi harus dikalikan dengan (1,65 - 0,0003wc) tetapi tidak kurang dari 1,09. 

  (b) Untuk fy selain 420 MPa, nilainya harus dikalikan dengan (0,4 + fy/700). 

*Sumber : Tata Cara Perencanaan Struktur Beton Bangunan Gedung (SNI 

2847-2013 hal 70) 

- Menghitung beban mati pelat termasuk beban sendiri pelat  dan beban 

hidup serta menghitung momen rencana (Wu).  

   Wu   = 1,2 WDD + 1,6 WLL 
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   WDD = Jumlah beban Mati Pelat (KN/m) 

   WLL=  Jumlah beban Hidup Pelat (KN/m) 

- Menghitung momen rencana (Mu) baik dengan cara tabel atau  analisis 

sebagai alternatif, metode pendekatan berikut ini dapat digunakan untuk 

menentukan momen lentur dan gaya geser dalam perencanaan balok 

menerus dan pelat satu arah,yaitu pelat beton bertulang di mana  

tulangannya hanya direncanakan untuk memikul gaya-gaya dalam satu  

arah, selama:  

- Jumlah minimum bentang yang ada haruslah minimum dua, 

- Memiliki panjang bentang yang tidak terlalu berbeda, dengan rasio 

panjang bentang terbesar terhadap panjang bentang terpendek dari dua 

bentang yang bersebelahan tidak lebih dari 1,2, 

- Beban yang bekerja merupakan beban terbagi rata, 

- Beban hidup per satuan panjang tidak melebihi tiga kali  beban mati per 

satuan panjang, dan 

- Komponen struktur adalah prismatis. 

- Perkiraan Tinggi Efektif ( deff ) 

 

Untuk beton bertulang, tebal selimut beton minimum yang harus 

disediakan untuk tulangan harus memenuhi ketentuan sebagai berikut 

sesuai SNI 2847-2013 halaman 51. 

Tabel 2.2 

Untuk beton bertulang, tebal selimut beton minimum  

: 

 Tebal Selimut Minimum  (mm) 

(a) Beton yang dicor di atas dan selalu 

berhubungan dengan tanah 
75 

(b) Beton yang berhubungan dengan tanah  
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atau cuaca: 

Batang D-19 hingga D-57............................. 

Batang D-16, kawat M16 ulir atau polos dan 

yang lebih kecil ........................................ 

 

50 

40 

c) Beton yang tidak berhubungan  dengan 

cuaca atau berhubungan dengan tanah : 

Slab, dinding, balok usuk: 

Batang tulangan D-44 dan D-

57........................................................... 

Batang tulangan D-36 dan yang lebih kecil 

................................................................ 

Balok, kolom: 

Tulangan utama, pengikat, sengkang,  

spiral..............................................................

. 

Komponen struktur cangkang, sengkang 

spiral: 

Batang tulangan D-19 dan yang lebih besar 

............................................................... 

Batang tulangan D-16, kawat M-16 ulir atau 

polos, dan yang lebih kecil………………… 

 

 

 

 

40 

20 

 

 

40 

 

 

20 

 

13 

*Sumber : Tata Cara Perencanaan Struktur Beton Bangunan Gedung (SNI-03-

2847-2002 hal 41) 

- Menghitung kperlu 

  

 

  K = faktor panjang efektif komponen struktur tekan (Mpa) 

  Mu = Momen terfaktor pada penampang  ( KN / m ) 
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  b = lebar penampang ( mm ) diambil 1 m 

  def = tinggi efektif pelat ( mm ) 

   Ø = faktor Kuat Rencana ( SNI 2847-2013 Pasal 9.3, butir ke- 2 hal 66) 

 

-  Menentukan rasio penulangan (ρ) dari tabel. 

 Jika ρ, maka pelat dibuat lebih tebal. 

 

- Hitung As yang diperlukan. 

 As = .b.deff 

 A     = Luas tulangan ( mm
2
) 

  = rasio penulangan 

 = tinggi efektif pelat ( mm ) 

 

- Memilih tulangan pokok yang akan dipasang beserta tulangan suhu dan 

susut dengan menggunakan tabel. 

Untuk tulangan suhu dan susut dihitung berdasarkan peraturan SNI 

2847-2013 Pasal 7.12, yaitu :  

1. Luasan tulangan susut dan suhu harus menyediakan paling sedikit 

memiliki rasio luas tulangan terhadap luas bruto penampang beton 

sebagai berikut, tetapi tidak kurang dari 0,0014; 

a. Slab yang menggunakan batang tulangan ulir Mutu 280 

atau350……….0,0020 

 

b. Slab yang menggunakan batang tulangan ulir atau tulangan kawat 

las Mutu 

420…………………………….……………………………………

…….0,0018 

c. Slab yang menggunakan tulangan dengan tegangan leleh melebihi 

420 MPa yang diukur pada regangan leleh sebesar 0,35 persen 

…………..0,0018x420/fy 

-  Tulangan susut dan suhu harus dipasang dengan spasi tidak lebih dari 

lima kali tebal slab, atau tidak lebih jauh dari 450 mm. 
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-   Pelat dua arah (two way slab) 

Pelat dua arah adalah pelat yang ditumpu oleh balok pada keempat 

sisinya dan beban-beban ditahan oleh pelat dalam arah yang tegak lurus 

terhadap balok-balok penunjang. 

1. Mendimensi balok 

Tebal minimum tanpa balok interior yang menghubungkan 

tumpuan-tumpuannya, harus memenuhi ketentuan dari tabel 2.3 

Tabel 2.3 

Tebal Minimum dari Pelat Tanpa Balok Interior 

Tegangan 

Leleh fy 

Mpa 

Tanpa Penebalan Dengan Penebalan 

Panel eksterior 
Panel 

interior 
Panel eksterior 

Panel 

interior 

Tanpa 

balok 

pinggir 

Dengan 

balok 

inggir c  

  

Tanpa 

Balok 

Pinggir 

Dengan 

Balok 

Pinggir 

  

280 Ln/33 Ln/36 Ln/36 Ln/36 Ln/40 Ln/40 

420 Ln/30 Ln/33 Ln/33 Ln/33 Ln/36 Ln/36 

520 Ln/28 Ln/31 Ln/31 Ln/31 Ln/34 Ln/36 

a. Untuk konstruksi dua arah, ln adalah panjang bentang bersih 

dalam arah panjang, diukur muka ke muka tumpuan pada pelat 

tanpa balok dan muka ke muka balok atau tumpuan lainnya pada 

kasus yang lain 

b. Untuk fy antara nilai yang diberikan dalam table, tebal minimum 

harus ditentukan dengan interpolasi linier 

c. Panel drop didefinisikan dalam 13.2.5. 

d. Pelat dengan balok di antara kolom kolomnya di sepanjang tepi 

eksterior. Nilai α untuk balok tepi tidak bolek kurang dari 0,8. 

*Sumber : Persyaratan beton struktural untuk bangunan gedung  

(SNI-2847-2013 Tabel 9.5(c) hal 72) 
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2. Persyaratan tebal pelat dari balok 

Tebal pelat minimum dengan balok yang menghubungkan  

tumpuan pada semua sisinya harus memenuhi ketentuan ayat 11.5.3 butir 

2 tidak boleh kurang dari nilai yang didapat dari :

 

  
        

  

    
 

              
……….SNI 2847 – 2013 hal.72 (9.5.3.3) 

  
        

  

    
 

     
…………….SNI 2847 – 2013 hal.72  (9.5.3.3) 

3. Mencari αm dari masing-masing panel 

Mencari αm dari masing-masing panel untuk mengecek apakah 

pemakaian h coba-coba telah memenuhi persyaratan hmin. 

 Untuk  αm < 2,0 tebal minimum adalah 125 mm. 

 Untuk  αm ≥ 2,0 tebal minimum adalah 90 mm.   

pelat

balok




1      

n
m

4321 



     

     (SNI 2847– 2013 hal.72) 

4. Pembebanan pelat 

Perhitungan sama seperti pada perhitungan pembebanan pelat satu arah. 

5. Mencari momen yang bekerja pada arah x dan y 

Mx    = 0,001Wu L2 x koefisien momen 

My    = 0,001 Wu L2 x koefisien momen 

 Mtix  = ½ mlx 

 Mtiy  = ½ mly  
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 (Grafik dan Tabel Perhitungan Beton Bertulang hal.26) 

 Keterangan :    

 Mx = momen sejauh X meter 

My = momen sejauh Y meter 

6. Mencari tulangan dari momen yang didapat (Dipohusodo hal.214) 

Tentukan nilai 
2.db

Mu
K


  untuk mendapatkan nilai ρ (rasio tulangan) 

yang didapat dari tabel. 

 Syarat : ρmin ≤ ρ ≤ ρmax 

   











fyfy

fc

600

600
.

'..85,0
.75,0max


  

 Apabial ρ < ρmin maka dipakai tulangan 
fy

4,1
min    

   (Dipohusodo hal. 37 & 39 ) 

    As = ρmin .b.d 

    Keterangan : k = faktor panjang efektif 

                 Mu = momen terfaktor pada penampang 

                       Ø  = faktor reduksi kekuatan (0,8) 

                        b  = lebar daerah tekan komponen struktur 

             d  = jarak dari serat tekan terluar ke pusat tulangan    

       tarik 

                   ρmin  = rasio penulangan tarik non-prategang minimum 

                        As = luas tulangan tarik non-prategang 

                          fy = mutu baja 

                       fc’ = mutu beton 
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2.3.2  Perencanaan Tangga 

   Menurut  Supribadi,  1986, tangga adalah suatu kontruksi 

yang menghubungkan  antara tempat yang satu dan tempat lainnya 

yang mempunyai ketinggian berbeda, dan dapat dibuat dari kayu, 

pasangan batu bata, baja, dan beton. Untuk memperlancar hubungan 

antara lantai bawah dengan lantai yang ada di atasnya dalam suatu 

kegiatan, maka digunakan alat penghubung tangga.  Tangga terdiri 

dari anak tangga dan pelat tangga.  

 

Anak tangga terbagi menjadi 2 bagian, yaitu : 

1. Antrede, yaitu bagian dari anak tangga pada bidang horizontal yang 

merupakan bidang tempat pijakan kaki. 

2. Optrede, yaitu bagian dari anak tangga pada bidang vertikal yang 

merupakan   selisih tinggi antara 2 buah anak tangga yang berurutan.  

 

 

 

 

 

 

 

 

Gambar 2.2 Antrede dan Optrede anak tangga  

   Ibu tangga merupakan bagian tangga yang berfungsi mengikat 

anak tangga. Material yang digunakan untuk membuat ibu tangga 

misalnya antara lain,  beton  bertulang,  kayu,  baja,  pelat  baja,  baja  

profil  canal, juga besi.Kombinasi antara ibu tangga dan anak tangga 

biasanya untukv ibu tangga misalnya, beton bertulang di padukan dengan 

anak tangga dari bahan papan kayu, bisa juga keduanya dari bahan baja, 

untuk ibu tangga menggunakan profil kanal untuk menopang anak tangga 

yang menggunakan pelat baja.  

   Bordes biasa juga disebut Landing. Bordes merupakan bagian 
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dari tangga sebagai tempat beristirahat menuju arah tangga berikutnya. 

Bordes juga berfungsi sebagai pengubah arah tangga. Umumnya, 

keberadaan bordes setelah anak tangga ke 15. Kenyamanan bordes juga 

perlu diperhatikan, untuk lebarnya harus diusahakan sama dengan lebar 

tangga.  

   Pelengkap tangga, yaitu pegangan (railing) dan baluster . 

Ukuran pegangan railing tangga dengan ukuran diameter 3,8 cm 

merupakan ukuran yang bisa mengakomodasi sebagian besar ukuran 

tangan manusia. Untuk kenyamanan pegangan tangga, perlu 

diperhatikan juga jarak antara railing pegangan tangga dengan jarak 

tembok, jarak 5 cm saya rasa sudah cukup. Baluster  merupakan  

penyangga  pegangan  tangga,  biasanya  bentuknya mengarah vertical. 

Material baluster bisa terbuat dari kayu, besi, beton, juga baja. Terkadang 

juga saya pernah melihat material baluster menggunakan kaca. Untuk 

keamanan dan kenyamanan pengguna tangga, usahakan jarak antar 

baluster tidak terlalu jauh, terutama untuk keamanan anak kecil.Untuk  

ukuran ketinggian baluster, standarnya kurang lebih antara 90-100 cm.  

 

Tabel 2.4 Jenis-jenis Bahan Untuk Tangga 

 
No. Bahan Tinjauan 

Keuntungan Kerugian 

1 Kayu -  Bahannya mudah didapat. 

-  Bobotnya ringan. 

-  Relatif lebih murah. 

-  Indah bila dipropil dan dipolitur. 

Untuk tangga rumah tinggal, villa, 

tangga sementara. 

- Konstruksi agak sulit dibuat 

kaku. 

- Lama pengerjaannya. 

- Lekas aus dan mudah. dimakan 

rayap. 

- Licin dilalui bila tanpa makai 

alas/karpet. 

2 Baja -  Kokoh, stabil. 

-  Tidak mudah aus. 

-  Bila berada di dalam rumah tidak 

banyak perawatan. 

-  Untuk tangga bawah tanah, 

tangga kebakaran, tangga untuk 

bengkel. 

- 
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3 Beton 

Bertulang 

-  Mudah dibentuk sesuai selera. 

-  Kokoh, stabil. 

-  Tidak mudah aus maupun 

terbakar. 

-  Tidak licin. 

-  Banyak digunakan untuk tangga 

rumah tinggal yang permanen 

atau tempat keramaian lainnya. 

- Bobotnya tinggi ± 2,4 ton per 

m3. 

- Harganya mahal. 

- Pengerjaannya lama karena 

memerlukan bekisting. 

- Proses pengikatan dan 

pengeringan cukup lama ± 28 

hari. 

4 Bata/Batu -  Biaya lebih murah dari tangga 

kayu, baja, beton tulang. 

-  Konstruksinya sederhana. 

-  Cepat pengerjaannya. 

-  Digunakan untuk tangga rumah 

sederhana, undak-undak pada 

tanggul bangunan irigasi. 

- Jumlah anak tangga terbatas. 

- Banyak memakan ruangan. 

- Cukup berat ± 1,7 ton per m3. 

- Konvensional/kuno. 

*Sumber:  Ilmu Bangunan Gedung, 1986  

 

Secara umum, konstruksi tangga harus memenuhi syarat-syarat 

seperti berikut:  

1. Tangga harus mudah dijalani atau dinaiki 

2. Tangga harus cukup kuat dan kaku 

3. Ukuran tangga harus sesuai dengan sifat dan fungsinya 

4 .Material yang digunakan untuk pembuatan tangga terutama pada 

gedung-gedung umum harus berkualitas baik, tahan dan bebas 

dari bahaya kebakaran 

5. Letak tangga harus strategis 

6. Sudut kemiringan tidak lebih dari 45 

 

          Di samping itu ada pula syarat-syarat khusus konstruksi tangga 

adalah sebagai berikut: 

  Untuk bangunan rumah tinggal : 

  Antrede = 25 cm (minimum) 

Optrede = 20 cm (maksimum) 

Lebar tangga = 80 - 100 cm 

 

  Untuk perkantoran dan lain-lain 

  Antrede = 25 cm (minimum) 
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Optrede = 18 cm (maksimum) 

Lebar tangga = 120 - 200 cm 

 

  Syarat langkah : 

2 optrede + 1 antrede = 57 - 65 cm  

  Sudut kemiringan,  maksimum = 45, minimum = 25  

 

 Berikut ini adalah langkah-langkah dalam perencanaan konstruksi 

tangga:  

1. Perencanaan tangga 

a. Penentuan ukuran antrede dan optrede 

b. Penentuan jumlah antrede dan optrede 

c. Panjang tangga = jumlah optrede x lebar antrede 

d. Sudut kemiringan tangga = tg ( tinngi tangga : panjang tangga ) 

e. Penentuan tebal pelat tangga 

  2. Penentuan pembebenan pada anak tangga 

a. Beban mati 

- Berat sendiri bordes 

-  Berat sendiri anak tangga 

Berat 1 anak tangga (Q) per m’ 

Q = antrede x optrede x 1 m x γbeton x jumlah anak tangga dalam 1 m 

        -  Berat spesi dan ubin 

         b.  Beban hidup 

      3. Perhitungan tangga dengan metode cross untuk mencari gaya- 

          gaya yang bekerja 

      4. Perhitungan tulangan tangga 

- Perhitungan momen yang bekerja 

- Penentuan tulangan yang diperlukan 

- Menentukan jarak tulangan 

-  Kontrol tulangan 
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2.3.3  Perencanaan Portal 

Portal adalah suatu sistem yang terdiri dari bagian-bagian struktur 

yang paling berhubungan dan berfungsi menahan beban sebagai satu 

kesatuan lengkap. Sebelum merencanakan portal terlebih dahulu kita harus 

mendimensi portal. 

Hal-hal yang perlu diperhatikan dalam pendimensian portal adalah sebagai 

berikut : 

a) Pendimensian balok 

Tebal minimum balok ditentukan dalam SK SNI 2847-2013 hal. 70 

adalah untuk balok dengan dua tumpuan sederhana memiliki tebal 

minimum ℓ/16, untuk balok dengan satu ujung menerus memiliki 

tebal minimum ℓ/18,5, untuk balok dengan kedua ujung menerus 

memiliki tebal minimum ℓ/21, untuk balok kantilever ℓ/8. 

b) Pendimensian kolom 

c) Analisa pembebanan 

d) Menentukan gaya-gaya dalam 

  Dalam menghitung dan menentukan besarnya momen yang bekerja 

pada suatu struktur bangunan, kita mengenal metode perhitungan 

dengan metode cross, takabeya, ataupun metode dengan 

menggunakan bantuan komputer yaitu menggunakan program 

SAP2000 V.14. 

 

Perhitungan portal ini menggunakan SAP 2000 V.14. Dimana langkah 

perhitungannya : 

1. Menghitung Portal Dengan Menggunakan Program SAP 2000 V.10 

  - Langkah-Langkah Perhitungannya : 

a. Buka Program SAP V.14 

b. Buka New Model 

c. Pada Bagan New Model tentukan satuan KN, m, C lalu klik 2D Frames 
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- Tentukan Number of Stories ( Jumlah Tingkat ) = 3 tingkat 

- Tentukan Number  of Bays ( Jumlah Ruang Kolom ) = 3 ruang 

- Tentukan Story Height ( Tinggi Tingkat ) = 4 m 

- Tentukan Bay Width ( Jarak Kolom ) = 3 m 

- Klik Ok 

 

Gambar 2.3 Menentukan dimensi Portal 

d. Hapus semua rangka batang, dengan cara memblock semua rangka 

yang   tergambar lalu di delete sehingga yang tampak hanya Grid nya 

saja. 

  e. Klik Menu Define > Coordinate System/Grid > Modify/Show System 

 - Ubah tinggi lantai ( X Grid Data ) sesuai perencanaan. 

 - Kilk OK > OK 
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Gambar 2.4 Bagan Define Grid System Data 

 

f. Klik menu Define > Section Properties > Frame Section  

 

Gambar 2.5 Frame Properties 

  - klik Add New Property 

 - pada Frame Section Property Type, pilih Concrete 

 - Klik Rectangular 
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Gambar 2.6 Add Frame Section Property  

 - Isi pada Section Name dengan Kolom 30x30 

 - Tentukan Depth ( tinggi balok ) = 0.30 

 - Tentukan Width ( lebar balok ) = 0.30 

 - Kilik OK 

 - Lakukan hal yang sama untuk membuat Property Balok Induk dan 

Ring Balok. 

 

Gambar 2.7 Rectangular Section 
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g. Klik menu Draw > New Labels  

 - Ganti angka Joint dan Frame/Cable menjadi angka 1. 

 

Gambar 2.8 New Labels 

h. Klik menu Draw > Draw Frame/Cable/Tendon 

 - Ubah Section menjadi Kolom 

 - Gambarkan Kolom sesuai dengan Grid yang telah dibuat 

            - Lakukan hal yang sama untuk menggambarkan Ring Balok dan Balok    

Induk. 

 

Gambar 2.9 Properties of Object 
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Gambar 2.10 Menggambar Rangka Portal 

i. Klik Joint pada tiap Pondasi 

 - Pilih menu Assign > Joint > Restraint, lalu pili Pondasi Jepit 

 - Klik OK 

 

Gambar 2.11 Joint Restraints / Pondasi 
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Gambar 2.12 Gambar Pondasi 

j. Pilih Menu Define > Load Patterns 

 - Ganti Load Pattern Name menjadi Mati,ubah Self Weight Multiplier jadi 

0 

 - Klik Add New Load Pattern 

 - Lakukan hal yang sama untuk menambah Beban Hidup 

 - Untuk Load Pattern DEAD bisa dihapus dengan cara klik Delete Load 

Pattern. 

 

Gambar 2.13 Define Load Patterns 
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k. Pilih menu Define > Load Cases > hapus DEAD dan MODAL  

 - Klik OK 

 

Gambar 2.14 Define Load Cases 

l. Pilih menu Define > Load Combination > Add New Combo 

 - Ubah Load Combination Name menjadi 1,2D +1,6L 

 - Pilih Load Case Name > HIDUP, lalu ganti Scale Factor menjadi 1,6, 

Add 

 - Pilih Load Case Name > MATI, lalu ganti Scale Factor menjadi 1,2, 

Add 

 - Klik OK > OK 
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Gambar 2.15 Load Combination Data 

m. Pilih Rangka Batang yang akan diberi beban 

 - Klik Assign > Frame Load > Distributed 

 - Ganti Load Pattern Name, jadi MATI untuk memasukkan beban MATI. 

 - Klik Add to Existing Load  

 - Masukkan beban merata pada Load, contoh 18,38 KN/m 

 - Klik OK 

 

Gambar 2.16 Frame Distributed Loads 
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 - Lakukan hal yang sama pada batang-batang yang lain 

 - Jika ingin memasukkan beban terpusat maka pilih Assign > Frame 

Load > Point, lakukan hal yang sama seperti di atas 

 - Untuk memasukkan beban HIDUP, maka pada Load Pattern Name 

ganti menjadi HIDUP, selanjutnya sama seperti di atas 

 

 

Gambar 2.17 Pembebanan Portal 
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Gambat 2.18 Hasil Perhitungan Pembebanan 

 

n. Pilih Menu Analyze > Run Analysis > Run Now, lalu simpan  

Untuk menampilkan gaya Normal, Lintang, dan Moment, pilih menu 

Display > Show Forces/Stresses, selesai. 

 

Gambar 2.19 Hasil Perhitungan Diagram Normal 
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Gambar 2.20 Hasil Perhitungan Diagram Lintang 

 

 

Gambar 2.21 Hasil Perhitungan Diagram Momen 
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2.3.4    Perhitungan Tulangan Balok 

Balok merupakan batang horizontal dari rangka struktur yang memikul 

beban tegak lurus sepanjang batang tersebut biasanya terdiri dari dinding, 

pelat atau atap bangunan dan menyalurkannya pada tumpuan atau struktur 

dibawahnya. 

  Adapun urutan-urutan dalam menganalisis balok : 

1.  Gaya lintang design balok maksimum 

       U  = 1,2 D + 1,6 L 

             (Istimawan hal. 40) 

      Keterangan :  U   = gaya geser terfaktor pada penampang 

               D    = beban mati terfaktor per unit luas 

               L     = beban hidup terfaktor per unit luas 

 

 

 

2.  Momen design balok maksimum 

Mu = 1,2 MDL + 1,6 MLL 

(Istimawan hal. 40) 

Keterangan : Mu = momen terfaktor pada penampang 

               MDL = momen akibat beban mati 

                MLL = momen akibat beban hidup 

 

3. Penulangan lentur lapangan dan tumpuan  

a. Penulangan lentur lapangan 

- Tentukan deff  = h – p – Ø sengkang  -  ½ Ø tulangan 

2.. db

Mu
K


 → didapat nilai  dari tabel 
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As = . b. d   (Gideon hal.54) 

-    Pilih tulangan dengan dasar As terpasang ≥ As direncanakan 

a. Penulangan lentur pada tumpuan 

-     
2.. db

Mu
K


 → didapat nilai  dari tabel 

  As = . b. d (Gideon hal.54) 

-     Pilih tulangan dengan dasar As terpasang ≥ As direncanakan 

Keterangan : 

As = luas tulangan tarik non-prategang 

   =  rasio penulangan tarik non-prategang 

                  Beff  = lebar efektif balok 

                      d = jarak dari serat tekan terluar ke pusat tulangan Tarik 

 

b. Tulangan geser rencana 

- Vc = 0,17 λ √    bw d 

                          (SNI 2847 – 2013 hal.89 pasal 11.2.1 butir 1)   

-   V ≤ Ø Vc (tidak perlu tulangan geser)  (Istimawan hal.113) 

-   Vu ≤ Ø Vn 

          -   Vn = Vc + Vs 

                      -   Vu ≤ Ø Vc + Ø Vs 

(Istimawan hal. 114) 

-     Sperlu =

S

V

V

dfyA ..
 

(Istimawan hal.122) 
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Keterangan : 

Vc = kuat geser nominal yang disumbangkan beton 

Vu = kuat geser terfaktor pada penampang 

Vn = kuat geser nominal 

Vs = kuat geser nominal yang disumbangkan tulangan geser 

Av = luas tulangan geser pada daerah sejarak s 

d = jarak dari serat tekan terluar ke pusat tulangan tarik 

fy = mutu baja 

 

2.3.5  Perhitungan Tulangan Kolom 

Kolom adalah komponen struktur bangunan yang tugas utamanya 

menyangga beban aksial tekan vertical dengan bagian tinggi yang tidak 

ditopang paling tidak tiga kali dimensi lateral terkecil. Sedangkan komponen 

struktur yang menahan beban aksial  vertical dengan rasio bagian tinggi 

dengan dimensi lateral terkecil kurang dari tiga dinamakan pedestal. 

(Dipohusodo, 1994:287) 

Adapun urutan-urutan dalam menganalisis kolom : 

1. Tulangan untuk kolom dibuat penulangan simetris berdasarkan 

kombinasi Pu dan Mu. 

Untuk satu batang kolom dan dua kombinasi pembebanan yaitu 

pada ujung atas dan ujung bawah pada setiap freebody, masing-masing 

dihitung tulangannya dan diambil yang terbesar. 

2.  Beban design kolom maksimum 

U = 1,2D + 1,6L  

(Istimawan hal. 40) 

Keterangan :  U  = beban terfaktor pada penampang 
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                D  = kuat beban aksial akibat beban mati 

     L  = kuat beban aksial akibat beban hidup 

3.  Momen design kolom maksimum untuk ujung atas dan ujung 

bawah. 

Mu = 1,2 MDL + 1,6 MLL  

(Istimawan hal. 40) 

Keterangan :   Mu = momen terfaktor pada penampang 

              MDL = momen akibat beban mati 

                      MLL = momen akibat beban hidup 

4.  Nilai kontribusi tetap terhadap deformasi. 

)6,1.2,1(

.2,1
.

LD

D
d


  

(Gideon hal.186) 

Keterangan :  ß  = rasio bentang bersih arah memanjang 

d =  jarak dari serat tekan terluar ke pusat tulangan  

tarik 

5.  Modulus Elastisitas 

  '4700 fcEC    fc’ = kuat tekan beton 

6.  Nilai kekakuan kolom dan balok 

Ik = 1/12 b h³ 

Ib = 1/12 b h³ 

 d

IE
IE

gC

K
.15,2

.
.


  → untuk kolom 
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 d

IE
IE

gC

b
.15

.
.


   → untuk balok 

(Gideon hal.186) 

7.  Nilai eksentrisitas 

U

U

P

M
e   

   (Istimawan hal.302) 

Keterangan :     e   = eksentrisitas 

     Mu  = momen terfaktor pada penampang 

 Pu = beban aksial terfaktor pada eksentrisitas yang    

diberikan 

8. Menentukan Ψa dan Ψb 























b

b

K

K

IE

IE

II

IE

.

.

.

.



  

(Gideon hal.188) 

9. Angka kelangsingan kolom 

Kolom langsing dengan ketentuan : 

- rangka tanpa pengaku lateral = 
r

Klu
 22 

- rangka dengan pengaku lateral = 
r

Klu
 34 – 12 















b

b

M

M

2

1  

(Istimawan hal.331) 

Keterangan : 

   k = faktor panjang efektif komponen struktur tekan 

   lu = panjang komponen struktur tekan yang tidak ditopang 

r  = jari-jari putaran potongan lintang komponen struktur 

tekan 



39 
 

 

10.   Perbesaran momen 

   ssbb xMxMMc 22    

  

0,1

1







Pc

Pu

Cm
b



  

  

0,1

1

1









Pc

Pus



  

4,04,06,0
2

1 
B

B

M

M
xCm  → kolom dengan pengaku 

Cm = 1,0  → kolom tanpa pengaku 

(Istimawan hal.335 dan 336) 

Keterangan :    Mc = momen rencana yang diperbesar 

         δ   =  faktor pembesaran momen 

            Pu  =  beban rencana aksial terfaktor 

        Pc  =  beban tekuk Euler 

 

 

11.   Desain penulangan 

  Hitung tulangan kolom taksir dengan jumlah tulangan 2% luas 

kolom 

   
bxd

As
 '  → As = As’ 

   (Istimawan hal.325) 

 

12.   Tentukan tulangan yang dipakai 

   
bxd

As pakai
 '  

13.   Memeriksa Pu terhadap beban seimbang 

         d = h – d' 
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  fy

d
Cb




600

600
 

      xCbab 1  

   003,0' x
Cb

dCb
fs 







 
  

     fyfs '  

    Pn =  (0,85 x fc' x ab x b + As' x fs' – As x fy) 

    (Istimawan hal. 324) 

    Pn = Pu → beton belom hancur pada daerah tarik 

Pn  Pu → beton hancur pada daerah tarik 

14.   Memeriksa kekuatan penampang  

- Akibat keruntuhan  tarik 

   












 




















bfc

ddfyAs
e

h
e

h
bfcPn

'..85,0

)'.(..2

22
.'..85,0

2

 

- Akibat keruntuhan tekan 

   

18,1
..3

..

5,0

'.

2

'

'
























d

eh

fchb

dd

e

fyAs
Pn  

    (Istimawan hal.320 dan 322) 

  Keterangan  :  ρ = rasio penulangan tarik non-prategang 

          ρ' = rasio penulangan tekan non-prategang 
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         As = luas tulangan tarik non-prategang yang dipakai 

                    As’ = luas tulangan tekan non-prategang yang dipakai 

d  = jarak dari serat tekan terluar ke pusat tulangan   

tarik 

d’ = jarak dari serat tekan terluar ke pusat tulangan     

tekan 

          b   = lebar daerah tekan komponen struktur 

         h   = diameter penampang 

          fc’ = mutu beton 

          fy  = mutu baja 

         e   = eksentrisitas 

 

2.3.6   Perencanaan Pondasi 

Pondasi pada umumnya berlaku sebagai komponen struktur 

pendukung bangunan yang terbawah dan berfungsi sebagai elemen 

terakhir yang meneruskan beban ke tanah. 

 

a. Jenis-jenis Pondasi 

1. Pondasi Dangkal (Shallow Footing) 

  Bila letak lapisan tanah keras dekat dengan permukaan tanah, 

maka dasar pondasi dapat langsung diletakkan diatas lapisan tanah 

keras tersebut, pondasi seperti ini disebut dengan pondasi dangkal. 

Pondasi Dangkal mempunyai beberapa jenis, yaitu : 

a) Pondasi Tapak Tunggal 

Digunakan untuk memikul beban bangunan yang bersifat 

beban terpusat atau beban titik, misal beban tower kolom pada 

bangunan gedung bertingkat, beban pada menara (tower), beban 

pilar pada jembatan. 

b) Pondasi Tapak Menerus 
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Digunakan untuk memikul beban bangunan yang 

memanjang, seperti bangunan dinding (tembok), konstruksi 

dinding penahan tanah. 

c) Pondasi Tapak Gabungan 

Digunakan untuk memikul beban bangunan yang relatif 

berat namun kondisi tanah dasarnya terdiri dari tanah lunak. 

 

2. Pondasi Dalam (Deep Footing) 

  Bila letak lapisan tanah keras jauh dari permukaan tanah, maka 

diperlukan pondasi yang dapat menyalurkan beban bangunan 

kelapisan tanah keras tersebut, pondasi seperti ini disebut dengan 

pondasi dalam, contohnya pondasi tiang dan pondasi sumuran. 

 

- Pondasi tiang pancang  

Pondasi tiang pancang dipergunakan pada tanah-tanah 

lembek, tanah berawa, dengan kondisi daya dukung tanah 

(sigma tanah) kecil, kondisi air tanah tinggi dan tanah keras 

pada posisi sangat dalam. 

 

Pondasi tiang pancang sendiri mempunyai beberapa jenis : 

a) Pondasi Tiang Pancang Kayu 

Pondasi tiang pancang kayu di Indonesia, dipergunakan 

pada rumah-rumah panggung di daerah Kalimantan, di 

Sumatera, di Nusa Tenggara, dan pada rumah-rumah 

nelayan di tepi pantai 

b) Pondasi Tiang Pancang Beton 

Pondasi tiang beton dipergunakan untuk bangunan-

bangunan tinggi (high rise building). Pondasi tiang pancang 

beton, proses pelaksanaannya dilakukan sebagai berikut : 
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- Melakukan test “boring” untuk menentukan kedalaman 

tanah keras dan klasifikasi panjang tiang pancang, sesuai 

pembebanan yang telah diperhitungkan. 

- Melakukan pengeboran tanah dengan mesin pengeboran 

tiang pancang. 

- Melakukan pemancangan pondasi dengan mesin pondasi 

tiang pancang 

 

Hal-hal yang perlu dipertimbangkan dalam menentukan jenis pondasi 

adalah sebagai berikut: 

1) Keadaan tanah pondasi 

2) Jenis konstruksi bangunan 

3) Kondisi bangunan disekitar pondasi 

4) Waktu dan biaya pengerjaan 

Secara umum dalam perencanaan pondasi harus memenuhi persyaratan 

sebagai berikut : 

a) Tegangan kontak pada tanah tak melebihi daya dukung tanah yang 

diizinkan. 

b) Settlement (penurunan) dari struktur masih termasuk dalam batas 

yang diijinkan, jika ada kemungkinan yang melebihi dari perhitungan 

awal, maka ukuran pondasi dapat dibuat berbada dan dihitung secara 

sendiri-sendiri sehingga penurunan yang terjadi menjadi persamaan. 

 

 

2.4 Pengelolaan Proyek 

Manajemen proyek (Pengelolaan Proyek) adalah merencanakan, 

mengorganisir, memimpin, dan mengendalikan sumber daya perusahaan  

untuk mencapai sasaran jangka pendek yang telah ditentukan. Lebih jauh, 

manajemen proyek menggunakan pendekatan sistem dan hirerki (arus 

kegiatan) vertikal maupun horizontal. 
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Fungsi dasar manajemen dikelompokkan menjadi 3 kelompok kegiatan, yaitu: 

1. Kegiatan Perencanaan 

a. Penetapan Tujuan (goal setting) 

Penetapan tujuan merupakan tahap awal yang harus 

dilakukan terlebih dahulu dengan menentukan tujuan utama yang 

ditetapkan harus spesifik, realistis, terukur, dan mempunyai durasi 

pencapaian. 

b. Perencanaan (planning) 

Perencanaan ini dibuat sebagai upaya peramalan masa yang 

akan datang dan perumusan kegiatan-kegiatan yang akan dilakukan 

untuk mencapai tujuan yang ditetapkan berdasarkan peramalan 

tersebut. Bentuk perencanaan dapat berupa perencanaan prosedur, 

perencanaan metoda kerja, perencanaan standar pengukuran hasil, 

perencanaan anggaran biaya, perencanaan program (rencana 

kegiatan beserta jadwal) 

2. Pengorganisasian (organizing) 

  Kegiatan ini bertujuan melakukan pengaturan dan 

pengelompokkan kegiatan proyek konstruksi agar kinerja yang 

dihasilkan sesuai dengan harapan. 

3.   Kegiatan Pelaksanaan 

a. Pengisian Staf (staffing) 

Tahap ini adalah perencanaan personel yang akan ditunjuk 

sebagai pengelola pelaksanaan proyek. Kesuksesan proyek juga 

ditentukan oleh kecermatan dan ketepatan dalam memposisikan 

seseorang sesuai keahliannya. 

b.   Pengarahan (directing) 

Pengarahan merupakan tahapan lanjutan dari pengisian staf, 

yaitu setelah dilakukan pengarahan berupa penjelasan tentang 

lingkup pekerjaan dan paparan waktu untuk memulai dan 

menyelesikan pekerjaan tersebut. 

c. Kegiatan Pengendalian 
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a) Pengawasan (supervising) 

Pengawasan merupakan interaksi antar individu-

individu yang terlibat dalam organisasi proyek. Proses ini 

harus dilakukan secara kontinu dari waktu ke waktu guna 

mendapatkan keyakinan bahwa pelaksanaan kegiatan 

berjalan sesuai prosedur yang ditetapkan untuk mencapai 

hasil yang diinginkan. 

b) Pengendalian (controlling) 

Pengendalian merupakan proses penetapan atas apa 

yang telah dicapai, evaluasi kerja dan langkah perbaikan bila 

diperlukan. 

 

 

c) Koordinasi (coordinating) 

Koordinasi yaitu pemantauan prestasi kegiatan dari 

pengendalian akan digunakan sebagai bahan untuk 

melakukan langkah perbaikan, baik proyek dalam keadaan 

terlambat maupun lebih cepat. (Wulfram I. Ervianto, Hal. 

1-5) 

 

2.4.1   Rencana Kerja dan Syarat-syarat 

Rencana kerja dan syarat-syarat adalah segala ketentuan dan 

informasi yang diperlukan terutama hal-hal yang tidak dapat 

dijelaskan dengan gambar-gambar yang harus dipenuhi oleh para 

kontraktor pada saat akan mengikuti pelelangan maupun pada saat 

melaksanakan pekerjaan yang akan dilakukan nantinya. 
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2.4.2 Rencana Anggaran Biaya 

Rencana Anggaran Biaya adalah perhitungan banyaknya biaya 

yang diperlukan untuk bahan dan upah, serta biaya-biaya lain yang 

berhubungan dengan pelaksanaan bangunan atau proyek tersebut. 

Anggaran biaya merupakan harga dari bangunan yang dihitung dengan 

teliti, cermat dan memenuhi syarat. Anggaran biaya pada bangunan 

yang sama akan berbeda-beda dimasing-masing daerah, disebabkan 

karena perbedaan harga bahan dan upah tenaga kerja. 

 

2.4.3 Rencana Pelaksanaan 

a.  NWP (Network Planning) 

Dalam menyelesaikan pekerjaan konstruksi dibutuhkan suatu 

perencanaan waktu yang akan diperlukan untuk menyelesaikan tiap 

bagian pekerjaan yang akan dilaksanakan. NWP adalah suatu alat 

pengendalian pekerjaan di lapangan yang ditandai dengan symbol 

tertentu berupa urutan kegiatan dalam suatu proyek yang berfungsi 

untuk memperlancar pekerjaan. 

Proyek konstruksi membutuhkan perencanaan, penjadwalan 

dan pengendalian proyek. Tujuannya adalah menyelaraskan antara 

biaya proyek yang optimal mutu pekerjaan yang baik / berkualitas, 

dan waktu pelaksanaan yang tepat. Karena ketiganya adalah 3 

elemen yang saling mempengaruhi. 

 

 

 

 

 

Gambar 2.22 Diagram NWP 

 

Ilustrasi dari 3 circes diagram di atas adalah jika biaya proyek 

berkurang (atau dikurangi) sementara waktu pelaksanaan 
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direncanakan tetap, maka secara otomatis anggaran belanja 

material akan dikurangi dan mutu pekerjaan akan berkurang, 

dengan demikian secara umum proyek Rugi. Jika waktu 

pelaksanaan mundur/terlambat, sementara tidak ada rencana 

penambahan anggaran, maka mutu pekerjaan juga akan berkurang 

maka secara umum proyek Rugi.  Jika mutu ingin dijaga, 

sementara waktu pelaksanaan mundur/terlambat, maka akan terjadi 

peningkatan anggaran belanja dengan begini secara umum proyek 

juga Rugi. 

 Proyek dapat dikategorikan mengalami untung jika waktu 

pelaksanaan lebih cepat selesai dari yang direncanakan dengan 

mutu pekerjaan tetap terjaga, secara otomatis akan ada keuntungan 

pada biaya anggaran belanja. 

Inti dari 3 komponen proyek konstruksi tersebut adalah 

bagaimana menjadwal dan mengendalikan pelaksanaan proyek agar 

berjalan sesuai dengan schedule yang tela ditetapkan, selesai tepat 

pada waktunya, sehingga tidak terjadi pengurangan mutu pekerjaan 

atau penambahan anggaran belanja. 

  

b.  Barchart 

Menguraikan tentang uraian setiap pekerjaan mulai dari tahap 

awal sampai berakhirnya pekerjaan. Bobot pekerjaan dan waktu 

pelaksanaan pekerjaan. 

 

c. Kurva “S” 

Kurva “S” adalah kurva yang menggambarkan kumulatif 

progress pada setiap waktu dalam pelaksanaan pekerjaan. Kurva 

tersebut dibuat berdasarkan rencana atau pelaksanaan progress 

pekerjaan dari setiap pekerjaan. 

 

 


